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Introduction

Congratulations! You have received a copy of the Crestron SIMPL software package. This exciting
software package helps you build programs for Crestron control systems, both with a graphical
programming environment called SIMPL and procedural languages called SIMPL+ and SIMPL# for more
advanced programmers.

Crestron has devoted a great deal of time and effort to make sure that the software you receive is "ready
for prime time." If you have any comments or suggestions, please refer to the contact options at
www.Crestron.com. Technical support questions should go to our hot line at 1-888-CRESTRON.

The following sections are available in the release notes:

General Notes and Issues
SIMPL Best Practices
SIMPL Features and Bug Fixes
Installing the Crestron Database and Device Database
Installing the SIMPL+ Cross Compiler
Installing the Crestron Toolbox

General Notes and Issues

General Notes:

Display of "(C:xx H:yy)" in Program Tree and System Configuration Tree: The F11 Key will toggle the display of
some debugging information on the Configuration Tree and Program tree. This data is meaningless to the
programmer, and harmless to display.

Known issues:
Replace Control System with sub-slotted devices:

Any programming on sub-slotted device cards that are fixed may not get copied over, even
if the new Control System is the same or has the same fixed cards.
Serial drivers may have issues when converting to from one control system to another.
When replacing a control system, you may find that SIMPL flags a subfolder as incomplete,
but none of the logic symbols appear to be incomplete. Right click on that subfolder and
select "Make Symbol Complete".

Double clicking on an .SMW to open a file may result in a dialog telling you the name has been
shortened by windows. If you save this version of the program, the filename will remain in the DOS
shortened filename notation. Please open programs from within the SIMPL File -> Open command.

There may be rare cases where trying to drag multiple signals to another symbol where there is more
than enough space for the signals to be dropped, will result in a dialog asking the programmer if they
want to expand the symbol. Answer yes and the signals will be copied and the symbol will only be
expanded as necessary.

When commenting out the control system node or the Logic node, you can no longer comment-in all
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folders beneath with ALT-F1 or the menu selection. You must do each subfolder manually.

Saving a Module losing data: Sometimes, if you save a module to a different name after performing a
save in the same session of SIMPL, the Symbol Tree category may get lost. If you don't see your module
appear in the Symbol Library, please open the module in SIMPL editor, edit the Module Header and
reselect the proper Symbol Tree category.

Error R6031 - Attempt to initialize the CRT more than once.
If you are getting this error when starting up, we recommend the following:

Click Start, click Run, type regedit, and then click OK.1. 
Locate the following registry subkey: HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Layers

2. 

In the right pane, right-click the registry entry for the Explorer.exe process, and then click
RENAME.

3. 

Rename to Explorer (remove the .EXE)4. 
Exit Registry Editor.5. 
Restart the computer.6. 
If the above does not help, or you cannot find the AppCompatFlags registry path, please try the
procedure using this path instead: HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Layers HKEY_LOCAL_MACHINE\Software\Microsoft
\Windows NT\CurrentVersion\AppCompatFlags

7. 

Windows 7 Users:
If you are using an HP Printer Driver, we have experienced start-up crashes. Updating to the "HP
Universal Printing PCL 6" driver for Windows 7 from the HP web site (version 5.1.0, May 10, 2010)
solves these issues.

File access errors on certain PC configurations:
Some PC environment/configurations can cause file open or compile errors in SIMPL, indicating certain
files could not be found or accessed. Try disabling Windows Indexing and Windows Search and, possibly,
disable anti-virus software.

ERROR (LGCMCVT283) General SIMPL+ failure on file....
If you get this error when compiling a program:

Try Recompile All again.
If you have multiple programs in the same folder, try creating an archive of each program and
locate each program in a separate folder.

Things to keep in mind:
When importing Crestron Modules to update and use as a user module, please make sure to verify
the Default Argument's Input, Parameter and Output Properties for completeness. About a year
after the original concept of these properties were introduced, Crestron added support of a "Is a
Signed Value" field for Parameter, Analog Input and Analog Output properties. SIMPL supports
backwards compatibility of this new property for modules that were saved before the new
property was introduced. However, if a programmer were to import a Crestron Module that was
created before the signed property was added, and there were parameters or analog inputs or
outputs that need to allow signed values, SIMPL will not allow negative values on data entry. The
workaround for this is simply to edit the properties of the desired Parameter or Analog Input and
click on the "Is a Signed Value" checkbox.
If an attempt is made to edit the "[Reference Name]" parameter from a SIMPL+ module that was
compiled in 2.07 through 2.08.14, SIMPL will give an Invalid Parameter error message. If a
module created before 2.07, which has a reference name entered into the "[Reference Name]"
field is compiled in any of these versions, the compiler error log will have a message about an
invalid partial substitution. Two solutions exist: Either delete the reference name or compile in
2.08.18 (or later).
If programming a module to have Input/Output Groups and the label for the [~BeginGroup~] is
different than the label on the associated [~EndGroup~], SIMPL does not flag this and thus, when
using that module in a program, collapsing and expanding that group may not work properly.
Please edit the module and make sure the labels match.
When using the "Make Symbol Complete" option, it will not necessarily complete the symbol's
parameters if the parameter has no default value.
When importing a Crestron SIMPL Module or a Crestron SIMPL+ Module, please remember to
double check that the Symbol Tree category (#Category in SIMPL+) is not 0. Often modules will
be set to 0 if they are used as part of other modules so as not to clutter up the symbol tree in the
Program Manager. If the module is saved as a user module and compiled with the tree still set to
0, it will not be visible to the programmer.
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When commenting out the control system node or the Logic node, SIMPL no longer shows the
control system / logic node as commented out. This is correct.
C2N-IO: The RTS/CTS Hardware Handshaking serial setting has been removed from this device in
Device Database version 49.00.002.00 and later. If a program has an older version of this device,
and RTS/CTS was selected as the Hardware Handshaking option, the RTS/CTS setting will still be
set, even if using a newer Device Database. Doing a Replace Device will not clear this setting.
Since this method is not supported by the C2N-IO, programmers should update the Hardware
Handshaking to a recognized setting, or, add a new instance, copy the programming and delete
the original instance.

Crestron Database Version for SIMPL 4.x
Crestron Database version 34.01.002.00, or newer, is recommended for SIMPL version 4.01 and
higher. SIMPL+ fixed an issue that required us to have to fix and rebuild 3 Crestron SIMPL+
modules. The following 3 modules will have compile errors if compiled using SIMPL 4.x and a older
Crestron Database version. Kaleidescape SATP Processor v7.0.0.csp (Kaleidescape SATP Processor
v7.0.0 (cm)) DSC PowerSeries LED to Text v1.0.csp (DSC PowerSeries LED to Text v1.0 (cm))
HoneyA.csp (Honeywell Enviracom Processor (cm))

SIMPL+ changes to functionality:
for #INCLUDE_SIMPLSHARP_LIBRARY version 4.02.17 and higher, Absolute Paths are no longer
accepted within the compiler directive, #INCLUDE_SIMPLSHARP_LIBRARY. Both Absolute and
Relative Paths are now supported using the compiler directive, #INCLUDEPATH. One or more
#INCLUDEPATH directives can be specified and must be placed before any
#INCLUDE_SIMPLSHARP_LIBRARY compiler directives. The search order for libraries is 1) Project
Folder, 2) Global SIMPL+ Folder and 3) #INCLUDEPATH folders.
CONTINUE statement in SIMPL+: with the added support of the CONTINUE statement in SIMPL+,
any existing modules that use the word 'Continue' as a variable will not compile correctly. Please
change the variable name and recompile.

Windows 10 is a supported operating system.

SIMPL Best Practices

Sharing SIMPL Programs:
Share programs with other users via SIMPL created archives.

There are often support files (such as user/project modules or captured copies of Smart Graphics
extender data last imported), that will be required to successfully open and compile a SIMPL
program. A SIMPL generated archive will ensure that all required support data is captured and
available.

SIMPL 4.06.01 and higher will automatically create an archive on File->Save and File->Save As to make
sharing even easier.

Archives created on Save/Save As will be in: project_name_archive.zip, in the project folder.

Modifying someone else's code:
Create your own subsystem folder and comment out their code first.
Don't delete their code unless you have properly verified your code is working.

Code organization: Sub-folders in your SIMPL program, organized by functionality, is strongly recommended
for projects with a large code set.

Recommended locations for SIMPL and touch screen projects:
Although SIMPL does support storing all SIMPL projects and touch screen projects in 1 folder, Crestron
recommends separate folders for each.

Try to keep copies of the VTPro-e Smart Graphics projects available for when opening a SIMPL
program that is linked to a VTPro-e project.
Avoid manually removing or moving ".sgd_" files associated with VTPro-e projects actively
referenced by a SIMPL program. The ".sgd_" files represent the Smart Graphics data that was last
imported/refreshed in the SIMPL program and are required to successfully open a project with
Smart Graphics data.

Putting the name of the device on the VTPro-e project folder can be helpful.

Working over a network or the Cloud:
Don't work directly off of a cloud hard drive such as Drop Box.
When working with programs whose SMW and/or referenced module files are located on a network
drive, make sure to map that drive and make sure the permissions are set for create/delete/read/write.
Unmapped drives do not always work.
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Signal Naming can be key:
Use basic programming principles: Device/Symbol_Function_Algorithm_Step. Example:
TP01_Lights_Presets_1 IL_Lights_Preset_1_Fb

To maximize speed and efficiency of SIMPL, when at all possible, store user modules in project folders. The
larger the User Module folders, the longer it will take for SIMPL to start up.

Never edit SIMPL program or user modules files outside of SIMPL.

Hiding/Showing empty slots in System Configuration Tree:
Users can select to Hide Unused option on the System Configurtation tree context menu to show/hide
empty slots under a parent device.
To set a 'Hide Unused' state that will be remembered from program to program, and SIMPL session to
SIMPL session, select this option at the Control System level. Every time a program is created or
opened, this state will be applied to all nodes under the Control System.
Best Practices recommend to pick a Hide Unused state, for the whole program, that is most often used.
To toggle the state of a particular node, select the node and either hit F8 or, right click and toggle this
state via the context menu. Note: selections at the non control system nodes will only remain in effect
for that node, until the program is closed.

Resolving signals that have no driving source or destination: Before compiling, enable the
Preferences->Program Editing->Display signal connection status. This will show all signals without full
connections, in the colors indicated in the "Signal connection color theme" on that same preferences dialog.
Then view the symbols in the Symbol Detail View to identify the unconnected signals for resolution.

SIMPL Features and Bug Fixes

Fixes/Changes from 4.09.03 to 4.09.04

Notice: Work around for DM Endpoints set to IP ID 01 after a replace control system: When replacing
a DMPS3-4K control system to it's non 4K model, DM endpoints are being moved to IP ID 01. This is
an illegal IP ID and the program will not upload. To work around this:

Use the Configuration dialogs of the DM Endpoint to set the IP ID to a valid address
Or, remove the DM Endpoint and re-add it to the converted program. This will be fixed in the next SIMPL
version.

SIMPL Bug Fixes:

Fixed UI performance issues in the Symbol Detail view. Most apparent in very large programs.

SIMPL Enhancements::

Added an option to disable showing the signal connection status (no driving source and/or no routing) in
different colors. This option, "Display signal connection status", and the color selection, is on the
Preferences->Program Editing dialog.

Fixes/Changes from 4.08.15 to 4.09.03

SIMPL Bug Fixes:

Fixed issue with DM IO Blades showing up out of order in the Program tree.

SIMPL Enhancements::

F8 will now toggle the Hide Unused slots option in the System Configuration tree at the selected node.
Note: To set a 'Hide Unused' state that will be remembered from program to program, and SIMPL
session to SIMPL session, select this option at the Control System level. Every time a program is created
or opened, this state will be applied to all nodes under the Control System.
To toggle the state of a particular node, for the current programming session, select the node and either
hit F8 or, right click and toggle this state via the context menu. Note: selections at the non control
system nodes will only remain in effect for that node, until the program is closed.

Added support for the DM XIO Director and DM-NVX products.
DM-XIO-DIR-ENT director models, when added to an IP ID on the Ethernet card, will reserve another 3
IP IDs for required run time support. When adding a DM-XIO-DIR-ENT, you will need to add this to an IP
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ID where there are 4 contiguous IP IDs available.

Added ability to add multiple instances of a device, from the System Configuration tree:
This feature lets the user select which address to start adding the device instances.
This will be enabled for any slot, or parent device, that you can currently add a device to.
To use this feature, select either an empty slot or a parent device under which to add multiple copies of
a device.

Either press SHIFT and Double Click the Left mouse, or Right click and select "Add multiple copies
of device to:" (if this option is disabled, then multiple device instances cannot be added at that
location).
On the Add/Replace dialog, select the device and dismiss the dialog
A dialog will appear asking how many copies
Enter a value and select OK
If there are enough empty slots to add the selected number, the devices will be added to the first
empty slot and so on
If there is not enough room, a dialog will display telling the user how many instances could not be
added.

Added easy identification of signals that have no driving source or destination: Signals that have no driving
source will now show in red. Signals that have no destination will now show as green. Programmers can change
the assigned colors to these signals via the Options->Preferences->General tab, in the Colors section.

SIMPL+ Bug Fixes:

Fixed a compiler issue that was sometimes generating unnecesary errors regarding NVRAM.
Fixed an issue with compiles crashing SIMPL if the .NET 3.5 Compact Framework is not intalled. Users will now
get a message requesting them to reinstall SIMPL.
Added better handling to issues currently showing up as 'General SIMPL Failure on DLL' during compilation.

Fixes/Changes from 4.07.03 to 4.08.15

SIMPL Bug Fixes:

Fixed issue in compilation of SIMPL+ modules where, in some instances, runtime symbol parameter definitions
do not match design time definitions.
Fixed compilation issue for DMPS3-4K control systems. For correct runtime functioning of the DMPS3-4K
control systems.

install Device Database 88.05.00 or higher.
load DMPS3 4k firmware version 1.022.055 or higher.

Fixed issue with COM port replacement and IR device moves, when replacing a CP3 with another control
system.

Fixed issue when, sometimes, adding or renaming a signal would not apply the new name.

Signal Multi-Select when Signal Completion is enabled: when editing a signal name, to enter Multi-Select
mode, hold the SHIFT key and press either the Up or Down arrow key to end signal editing and enter the
selection mode.

Fixed performance slow down when Signal Completion is enabled in large programs.

Fixed issues with Replace Control System not moving IR drivers to the proper port on the new control system.

Device Upgrade:
Added support to report the need for a device replace when Device Symbols have changed.
Fixed issues with Device Replace/Upgrade Assist losing some programming.

IP-ID of DM Endpoints, added directly to the Ethernet card, will now show in the proper order by IP-ID in the
Program tree.

Note: existing programs showing the IP-IDs out of order will not reflect this fix unless you change the
IP-ID to something else, then change it back.

If a logic is module is added to the program by SIMPL (for example, a module that supports a device or Smart
Graphics data), the module comment in the Programming Tree will now reflect the associated device address.

Fixed an issue with expanding and contracting the outputs on Roomview Analog symbols. Deleting outputs (via
Alt-) was causing the symbol's I/O structure to become corrupt.

SIMPL Enhancements:

DSP Symbol Export Support: Added support for programming of DSP controls (such as Crosspoint Mutes, Level,
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etc) exported from an Crestron Avia project.
In the Avia tool:

Select the 'Symbol Export' tab, select the controls to be programmed, and select 'Save Symbols'
from the File menu (refer to Avia Help for detailed instructions).
Avia will generate a 'DSP Symbol Join' file, with the file type of .DSJ.
Take note of the DSP model and the location of the exported .dsj file(s).

In SIMPL: (requires Device Database 86.05.002 and Crestron Database 63.06.003 or higher):
Symbol Export files may only be imported to DSPs of the same type from which they were
exported (i.e. DSP-1280 can only import DSP-1280 symbol expoorts, etc).
Adding a DSP Custom Symbol (a.k.a DCS):

Add the proper DSP device to your program.
In the Programming Tree, select the DSP device, right click and select 'Import DSP Custom
Symbol...'
Navigate to, and select, the symbol export .dsj file.

Only 1 instance of a symbol export file can be assigned to the same DSP.
A DSP can have a maximum of 64 DCS symbols.

SIMPL will add a DCS symbol to the bottom of the DSP device.
Double click on that symbol to view and program it in Detail View.

There is 1 input for every exported control.
There is 1 feedback output for every exported control

Updating/Re-syncing the symbol definition for a DCS symbol in SIMPL:
In the Program Tree, select a specific DCS symbol:

Re-syncing symbol definition: Right click and select 'Resync DSP Custom Symbol' to
update the symbol definition from an updated .dsj file with the same filename as was
originally imported.

If other DSP devices in the program reference the same DCS, the user will be
asked if all instances are to be resync'd. If not, then no resync will be
performed.

Changing the .dsj filename: Right click and select 'Change DSP Symbol Export
File...". SIMPL will prompt for the new .DSJ file and will then resync the existing
symbol definition for the selected DCS, retaining as much programming as possible.

If other DSP devices in the program reference the same DCS whose .dsj file is
being changed, the user will be asked if they want to change the .dsj file
associated with all instances referencing the current .dsj.

If the user says yes, to update all instances, then all DCS's will be
updated to the newly selected file. If the user says no, only the selected
instance will get the newly selected file.

If the newly selected file is already referenced by other DCS's on other DSP
devices, the user will be asked if they want to resync the those instances also.
If not, no resync or file change will be performed.

In the case that the original .DSJ file cannot be found (i.e. SIMPL archive imported to
a different computer or folder), either the 'Resync' or 'Change File' options will
prompt the user through selection of a proper .DSJ file.

Duplicate Programming: Users can duplicate the programming of a DSP and it's DCS symbols to
another DSP of the same type (i.e. DSP-1280 to DSP-1280).
DCS symbols cannot be copied to other DSPs.

Do not attempt to rename a DSP Symbol export .dsj files outside of the Avia tool. It will not work in SIMPL. To
rename an Avia symbol export:

In the Avia tool File menu, select to "Load Symbols" and select the .DSJ file you want to rename.
After that file is loaded, select "Save Symbols" from the File Menu and provide the new name.

Fixes/Changes from 4.06.01 to 4.07.03

SIMPL Enhancements:

Upgrade Assist: On program open, if the current Device Database contains any device or symbols with newer
versions than what is currently in the program, SIMPL will display the Upgrade Assist dialog:

Upgrade Assist will display the devices and/or symbols in the program that should be upgraded.
User will select which devices/symbols to upgrade.
SIMPL will attempt to replace the selected devices/symbols with the latest versions, and will present the
user with the results.
If there were any errors during the upgrade, error messages will appear in the Error Log.

Select to generate AutoUpdate files: Users can disable the creation of the <program name>="">.lpz.hash, and
<program name>="">.smft (AutoUpdate skeleton manifest) file that is used by the Crestron Auto Update tool.

This can be disabled on the Options->Compiler settings dialog.

Signal Completion: Entering a signal name on an Input or Output in the Symbol Detail view will now provide a
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list of similar signal names for quicker programming.

Better "Duplicate Programming" support:
SIMPL no longer requires the target and source to be the exact same device symbol.
Programming can be duplicated between any target and source that have been deemed compatible.

Device symbol compatibility is defined in the Device Database. Device Database version 82.05.00,
or higher, should be used for this expanded flexibility.

If the target and source are deemed compatible, the Duplicate Programming context menu
option will be enabled.

User and Project modules will now show with unique icons: To help users better know where their modules are
coming from, project modules will now show with a new icon that has a white background.

Module Help: Module programmers can now select their help files to be in different file types.
The approved file types will be defined in Device Database 82.05.00 or higher. These are: pdf, docx,
doc, rtf, txt, html, xls
If Device Database 82.05.00 is not installed, .PDF files will be the only supported type.

SIMPL Bug Fixes:

Fixed bug with selecting not to save the program on compile. SIMPL was aborting the compile instead of
compiling the version of the program that is in memory.

Fixed bug with saving programs to a different folder and project data was not being copied to the new location.

SIMPL+ Bug Fixes and Enhancements:

Added verification logic to ensure that all SIMPL# assemblies in a system are dependent on the same S# SDK
version.

Fixes/Changes from 4.06.00 to 4.06.01

SIMPL+ Bug Fixes and Enhancements:

Resolved issue with compilation of modules with SIMPL# having compilation errors and/or crashing SIMPL.
Minimum DB Requirements:

Device DB: 81.05.003
Crestron DB: 61.05.007

Fixes/Changes from 4.05.04 to 4.06.00

SIMPL Bug Fixes and Enhancements:

Added a link to the Crestron Application Market website from the Symbol Library. Selecting Help/F1 on this link
will provide users with instructions on how best to use files from the Crestron Application Market, inside SIMPL.
Clicking on the URL will launch the website from the user's default browser.
SIMPL will now create an archive of the SIMPL program or SIMPL module on File Save/Save As.

The archive file will be named "program name_archive.zip" and will contain the latest saved source files
for the program, and the latest compiled output files from the last compile.
Users can disable automatically archiving SIMPL programs and SIMPL Modules on File Save/Save via the
Options->Preferences->General settings.
Users can still use the File Menu->Create Archive option to to capture archived data on demand (i.e.
copies they don't want to lose on the next Save/Save As). The default archive name, for user driven
archives, is "program name.zip".

Resolved an issue with F5 (refresh) when a program was not open, causing SIMPL to crash.
Added support for replacing DMPS3 control systems with the new DMPS3-4K models. A new Device Database,
version 82.00 or higher, will be required for this support.
SIMPL will no longer put the program archive file (<program name>="">_archive.zip) in the boot file for
3-series programs. Currently, when this archive was listed in the boot file and if the archive is removed from
the control system, the control system will still successfully reboot. This was only happening if the compiler
option to 'Create archive and embed into compiled program' was selected.
Fixed error when the user option for 'Save Options before Compile' is set to 'Ask First' and user selects not to
save when asked. Compilations were not happening in this scenario. With this fix, SIMPL will still compile even
if the program has not been saved. The program in memory will get compiled but the disk file will still reflect
whatever was last saved. This option can be found under the SIMPL Windows Preferences->General settings.
Added an option "Generate Auto Update data on compile" to the Options->Preferences->Compiler Settings. If
deselected, AutoUpdate files will not be generated on compile.

SIMPL+ Bug Fixes and Enhancements:
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Added support for 2 new SIMPL+ Extended Gather functions: GatherWithDest and GatherByLengthWithDest.
Fixed an issue with missing SIMPL# assemblies in .LPZ after a recompile. This would only happen if the SIMPL+
module referencing the assembly was open in the SIMPL+ editor, and the SIMPL program that referenced that
SIMPL+ module was compiled.

Fixes/Changes from 4.04.03 to 4.05.03

SIMPL Bug Fixes and Enhancements:

Added support for HDMI connectivity of DM-RX-4K-1000-SFP and DM-TX-4K-1000-SFP (FSTR) endpoints for
Digital Media. These endpoints operate either as a transmitter or receiver and can be connected via Ethernet or
HDMI. In both cases, the FSTR will be assigned an IPID.

A minimum 3-series control system firmware version of 1.501.0025 is required with SIMPL 4.05.01.
Fixed issue with program filenames that had their file extension changed to upper case (i.e. .SMW). This could
cause corruption of the program file on compile.

Fixes/Changes from 4.03.24 to 4.04.03

SIMPL Debugger performance has been greatly improved. Install Toolbox 2.42.236, scheduled for release July
1, 2016

SIMPL Enhancements:

Added logic to reduce the SIMPL startup time. To take advantage of this, Device Database version 77.00.00 or
higher will be required.
Added a Project Menu option to generate the Skeleton Manifest file for the Auto Update tool. Device Database
version 77.00.00 or higher will be required for this feature to operate properly.
Added Project Menu options 'Resync User Data' and 'Resync Project Data'. The user can now select to resync
their programs for just the selected data type.
When performing a 'Resync Project', on the dialog that asks if the user wants to reload the library data, the
default for this has been changed to No. This will help users that hit Return on that dialog and end up waiting
for the data to be reloaded.
Added the ability to name a subfolder in the Program tree at the time the folder is added. F2 will also enable
changing the folder name.
Added logic to the Smart Graphics management "Confirm Synchronization" dialog where SIMPL will now show
what could be possible matches between the latest VTPro-e controls and current Smart Graphics extenders in
the SIMPL program.

BACnet: added support for allowing up to 2000 BACnet objects in a system, based on the Control System's
limitations.

To take advantage of this, Device Database version 77.00.00 or higher will be required.
NOTE: When expanding the Host and Remote BACnet cards in the System Configuration tree, the user
will no longer see empty slots in which they can add other BACnet devices.
The System Configuration tree will show a label to the right of the top level BACnet card, identifying the
number of BACnet objects that can still be added to the control system.
Programs created containing BACnet devices, using this new limitations support, will not be allowed to
open in previous versions of SIMPL.
To add a BACnet device:

In the System Configuration tree, double click on the parent card to which the device is to be
added.
Or, in the System Configuration tree, right click on the parent card to get the context menu
Add/Replace options.
Or, in the Device Library, select the BACnet device to be added, right click on that device and
select the appropriate 'Add' option (you can add just 1 or specify a number to add at one time).

Opening programs with BACnet devices saved in earlier versions of SIMPL, using the latest Device
Database:

SIMPL will prompt the user to replace the top level BACnet card.
Performing a replace of the BACnet card will upgrade the program to adhere to the control system
limits for maximum BACnet objects.
If the control system in the program supports less BACnet devices than are in the original
program, SIMPL will let the user know how many BACnet devices exceed the newly defined
control system's limit and, thus would be deleted on program open.

Replace Control System:
If the new control system supports less BACnet objects than the control system being replaced:

SIMPL will let the user know how many BACnet devices exceed the new control system's
limit and, thus would not be copied to the new control system.

Added node level support of 'Hide Unused' option in the System Configuration tree:
Selecting 'Hide Unused' from the Control System node, will hide/unhide empty slots in the whole tree.
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Selecting 'Hide Unused' from any other node in the tree will hide/unhide empty slots under that node
and all empty slots below that node.

SIMPL Bug Fixes:

Fixed error in 'Duplicate Device Programming' such that it is not case sensitive.
Fixed crash when copying programming from 1 BACnet device symbol to another.
Addressed Windows 10 related crashes.

SIMPL+ Bug Fixes and Enhancements:

Added SIMPL+ Extended Gather support:
Added a new GatherEventHandler.
Added the following functions for Extended Gather:

GatherAsync
GatherAsynchByLength
RearmGatherAsync
RemoveGatherAsync

Fixed issue where DLLs, in the SPlusWork folder and .lpz, from previous compiles were not being removed on
compile when the assemblies are no longer referenced.

Fixes/Changes from 4.03.20 to 4.03.24

SIMPL Enhancements:

New look and process for Smart Graphics data management:

A reworked "Smart Graphics Management" dialog provides more flexibility for extender management.
When the dialog is first displayed, there will be no pending actions for any of the touch screens.
The user selects which touch screens to act on, and actions to be perform on the selected screens (e.g.
synchronize SG data, associate touch screen to a VTPro-e project, remove VTPro-e project).
When the user selects "Commit Changes", SIMPL will preprocess the selected actions and, if any existing
Smart Graphics extenders are to be commented out, the new "Confirm Synchronization" dialog will
provide the user with the ability to manually resolve items that SIMPL was not able to.
If multiple touch screens reference the same VTPro-e project, actions against that VTPro-e project will
be applied to each touch screen referencing that project.

Upgrading Projects for better Smart Graphics data synchronization
With a new algorithm available to better match VTPro-e Smart Graphics Controls to SIMPL Smart
Graphics Extenders available, users should recompile existing VTPro-e project data, and synchronize
SIMPL programs that currently contain Smart Graphics data, using the latest versions of VTPro-e and
SIMPL.
Before performing any further Smart Graphics programming on existing VTPro-e projects or SIMPL
programs containing Smart Graphics data, Crestron highly recommends the following:

Open VTPro-e projects in VTPro-e version 6.00.007 or higher, and recompile. This will generate
Smart Graphics data, to be consumed by SIMPL, that will lend to a higher success rate of
matching VTPro-e controls to the SIMPL Smart Graphics extenders.
Open SIMPL projects in this version of SIMPL or higher, and refresh the Smart Graphics data per
the instructions described in the sections below.

Basically, SIMPL will now identify to the user, Smart Graphics extenders that could not be
100% matched to a VTPro-e control.
Per the instructions below, the user can now tell SIMPL which VTPro-e controls correspond
to which SIMPL Smart Graphics Extenders.
Once this matching/syncing of controls to extenders is complete, Save the SIMPL Program.

"Smart Graphics Management" dialog:

Action Buttons: Possible actions to perform on a touch screen are selected via the buttons at the top of the list of
touch screens. Selected actions will be processed when the 'Commit Changes' is selected.

Sync: using the latest VTPro-e compiled output, SIMPL will attempt to update the Smart Graphics extenders to
reflect the latest VTPro-e data.
Browse VTP: select a VTPro-e project to assign to the selected touch screen(s)
Clear VTP: remove association of the VTPro-e project from the the selected touch screen(s) and comment out
the existing Smart Graphics extenders.
Cancel Pending: Do not process the selected actions on the selected touch screens (i.e. leave those touch
screens as they are).

Select All/Deselect All: selects all, or deselects all, touch screens for action assignment.
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List of touch screens:: The list of touch screens can be sorted by Pending Action, device address,
touch screen type, VTPro-e project or VTPro-e path.

The "Pending Action" column will show what action SIMPL will take on each screen if the user
commits the changes

No Change: There is a VTPro-e project associated with the touch screen but, the user has not selected an
action in this session.
No VTP: a VTPro-e project has not yet been associated with the touch screen.
Resync: SIMPL will get the latest VTPro-e data for the selected touch screen and refresh the Smart Graphics
data accordingly. If any extenders are to be commented out, the new "Confirm Synchronization" dialog will be
displayed upon 'Commit Changes'
Add: a VTPro-e project will be assigned for the first time to a touch screen.
Clear: the VTPro-e project association will be removed from the touchscreen, and all Smart Graphics extenders
will be commented out.
File Not Found: indicates the VTPro-e project could not be found in the location from which it was added.
Missing Data: a copy of the Smart Graphics data, that SIMPL captured to represent the current Smart Graphics
extenders, could not be found (Note; this can happen if users remove files from the SIMPL project folder or
move the .SMW file without it's support files).

Commit Changes: SIMPL will pre-process the "Pending Actions" showing for each touch screen. Based
on this processing, if any touch screen is marked for "Resync" and SIMPL could not find a 100%
match between the Smart Graphics controls in the VTPro-e data, to the Smart Graphics extenders in
the SIMPL program, the new "Confirm Synchronization" dialog will display.

Cancel: will leave this dialog without making any changes to the Smart Graphics data.

"Unmatched Extenders" dialog:
This dialog allows the user better control of synchronization of Smart Graphics data, in the cases where SIMPL
could not find a 100% match between existing Smart Graphics extenders and the most recent VTPro-e
controls.

List of controls and extenders, per touch screen: For every touch screen selected for "Sync" on the
"Synchronize Smart Graphics Extenders" dialog, that SIMPL could not synchronize with 100% certainty, that
touch screen, and the Smart Graphics data, will appear in this list.
"SIMPL Windows Extender": Smart Graphics extenders currently in the SIMPL program are defined by the
"Extender Name" and "Extender Smart Object ID" columns on the left.
"VTPro-e": Smart Graphics controls from the latest VTPro-e data are defined via the "VTP Object Name",
"Smart Object ID" and "Control Type" in the columns on the right.
VTPro-e controls that could not be matched up to a Smart Graphics extender will appear on separate lines with
an action of "Create". If the user does not force a match to any of these, new Smart Graphics extenders will be
added to the touch screen.
Smart Graphics extenders that could not be matched up to a VTPro-e control will appear on separate lines with
an action of "Disable". If the user does not force a match to any of these, the associated Smart Graphics
extenders will be commented out under the touch screen (the user can then copy the programming and delete
the commented out control as appropriate).

Action: in front of each control displays an ACTION that would occur if the user were to select "Commit
Changes".

Create: A Green plus sign implies that control from the VTPro-e data will be added as a new Smart
Graphics extender to the touch screen
Disable: A Red minus sign implies the Smart Graphics extender in the SIMPL program will be
commented out under that touch screen.
Match: A black circular arrow implies a probable match between VTPro-e Smart Graphic control and the
Smart Graphics extender, SIMPL will try to synchronize.

"Sort by":defines how to display the controls and extenders in the lists of controls and extenders.
Sort by Smart Object IDs will sort both the Smart Graphics Extender rows, and the VTPro-e control rows
by Object ID.
Sort by names will perform approximate name matching, attempting to locate extender and control
names that are similar, closer together to help the user match up controls.

"Apply matches to all screens with same VTP": This will let the user perform extender to control matching
on one touch screen, and result in all touchscreens with that VTPro-e project get the selected synchronization
upon commit.

Select this option before performing any matching.
If selected, when a "Force Match" is selected on one touch screen, the "Action" for that extender and
control on the other touch screens, will also show as "Match".

Controlling the synchronization: Using the buttons and selections above the list of touch screens, the user
can further define the synchronization of Smart Graphics Data to be performed:
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Force Match tell SIMPL to synchronize the data from the selected VTPro-e control with the selected
Smart Graphics extender:

using the data presented for each control, select a control from the VTP file
select a Smart Graphics extender that you would like to be treated as the same control
select "Force Match".

The 2 rows of data should then become 2.
The Action will be "Match"
upon "Commit Changes", SIMPL will update the Smart Graphics extender with the data for
the control from the VTP.

Unmatch: For controls that have the "Match" Action, the user can select "Unmatch" to tell SIMPL to
comment out the selected Smart Graphics extender, and add a new extender using the data for the
VTPro-e control.

The 1 row of data will then become 2.
The Action for the Smart Graphics extender will be "Disable"
The Action for the VTPro-e control will be "Disable"
upon "Commit Changes", SIMPL will comment out the Smart Graphics extender.

Commit Changes: SIMPL will process all touch screens that have a selected action on the "Synchronize Smart
Graphics Extenders" dialog, taking into account any forced match provided by the user on the "Confirm
Synchronization" dialog.

SIMPL Bug Fixes and Enhancements:

Fixed crashes and cleaned up error messages.
Fixed errors in Resync'ing program logic.
Modified the SIMPL+ compilation process to detect assembly filename collisions as a result of different Creston
and User modules using the same filename.
Fixed error where errors on a module save were not showing up in the Error Log
Fixed error with SIMPL archive not including .CLZ files all the time.

Fixes/Changes from 4.03.15 to 4.03.20

SIMPL Bug Fixes and Enhancements:

Fixed a bug where adding devices to a program from the Device Library tree was being denied (e.g. select a
device such as a Generic Relay, right click and select "Add Device" and the user would get a "could not add
device" message).
Fixed a bug in the display of HDBT IP IDs. In the Program Tree, the IP ID assigned to an HDBT parent device
was disappearing every time something was done in the symbol detail view window.
Corrected internal HDBT address management issues.

SIMPL+ Bug Fixes and Enhancements:

Fixed a bug where right clicking on "Open API for Static" was causing SIMPL+ to crash.
Optimized 3 Series S+ compilation to not compile a module if the source code or dependencies have not
changed since the last compilation.
Fixed exceptions in processing SIMPL # assemblies on machines that require encryption algorithms to be FIPS
compliant.

Fixes/Changes from 4.03.14 to 4.03.15

SIMPL Bug Fixes and Enhancements:

Fixed a bug that was causing some symbol data not to be read in from the device database.

Fixes/Changes from 4.03.10 to 4.03.14

SIMPL Bug Fixes and Enhancements:

Fixed security issue when compiling on a computer that requires FIPS compliance for encrypted SIMPL#
assemblies. This support requires Include4.dat version 2.02.046 or higher (Device Database 67.00.00 or
higher).

Paste Special Enhancement: Added an option to the 'Paste Special' dialog to select how many sets of the
selected signal(s), should be copied and have number in signal names incremented.

Currently, the Paste Special operation allows users to copy a signal or signals that has a number in the
signal name, increment the number and paste the new signals to the selected location.
This enhancment now gives the user the option to select the number of sets of the signal(s) to copy. The
number that is to be incremented by the Paste Special operation will be incremented one more for each
set that is copied. example:
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Room1_VolUp Room1_VolDown

copy these 2 signals select to Paste Special on an empty Input or Output ( Ctl+Shift+V or via the
Paste Special toolbar button 3rd button to the right of the Scissors button) On the Paste Special
dialog, select the number of sets to copy (e.g. 3) to get:

Room1_VolUp Room1_VolDown Room2_VolUp Room2_VolDown Room3_VolUp Room3_VolDown Room4_VolUp
Room4_VolDown

Refer to the Paste Special description in SIMPL Help for more details on how Paste Special
operates.

SIMPL+ Bug Fixes and Enhancements:

Fixes/Changes from 4.02.65 to 4.03.10

SIMPL Bug Fixes and Enhancements:

Added new 'Copy Signals Only' context menu option in the Programming Tree, to copy only the Inputs and
Outputs from the target symbol to the selected symbol. This can be used for copying Smart Graphics
programming to avoid having the Control Join ID of the destination symbol, overwritten with a duplicate value
from the target symbol.
Added ability to Quit the Smart Graphics Management dialog without applying any of the selections.
Added support of F1 Help for Smart Graphics Extenders. If there is no specific Help for a particular Smart
Graphics control, SIMPL will display a generic Help topic for Smart Graphics extenders.
Added logic to try to keep the error log showing Compile error messages until the user dismisses the Error Log.
This should aid the user in resolving compile issues by providing access to the error messages regardless of
what resolution activity is performed.

Reworked the Abort Compile function and re-enabled it on Windows 8.1 operating systems.
Fixed issue with losing BACnet symbol parameters when performing a replace control system.
Fixed issue with Replace Control System not copying over Device Extenders.
Fixed issue with Replace Control System losing bookmarks.
Fixed issues with Replace Control System rearranging, or not retaining, IP-IDs of ethernet devices.
Fixed issues with retaining the IP ID of DM devices upon replace.
Fixed issue with incorrect error messages when copying logic by Control Join ID.
Fixed issue with importing multiple VTPro-e projects that contained controls with the same name. This scenario
was sometimes causing data integrity errors.
Fixed issues in SIMPL Archive import when subfolders have been added (either manually or via the Add button
on the Archive dialog). If the subfolder contained any Smart Graphics files, they were improperly being
processed into the SIMPL project folder. SIMPL will now just archive the subfolder(s) and it's contents to below
the SIMPL project folder.

Further streamlined the upgrade process for people moving from .CED based Smart Graphics data to the newer
.SGD method of managing their Smart Graphics programming:

For older CED based programs, SIMPL will now support both SGD and individual CED files in the same
program. This will only be allowed under the circumstances defined below, such that programmers are
not forced to upgrade CED based Smart Graphics data, all at one time.

If an existing touch screen is upgraded to reference a VTPro-e program and use the SGD files,
individual CED files will not be allowed under that touch screen. Existing CED based Smart
Graphics extenders that exist on touch screens being upgraded to reference a VTPro-e project,
will still be commented out if a matching Smart Graphics definition cannot be found in the newly
imported SGD file.
The Smart Graphics Management dialog will have a solid grey arrow identifying the touch screens
whose Smart Graphics data still comes from CED files.
Touch screens in programs created after 4.02.21, or touch screens that have no Smart Graphics
data, will not be allowed to import CED files.
If a touch screen already references Smart Graphics extenders based on individual CED files, and
that touch screen is not upgraded to reference a VTPro-e project, the programmer will be allowed
to continue to manage the Smart Graphics data for that touch screen via the CED files. On these
touch screens:

The programmer can refresh individual CED files, import CED files, reorder Smart Graphics
extenders, copy programming, and delete Smart Graphics extenders based on individual
CED files for non-upgraded touch screens.
The programmer will also be allowed to 'Duplicate Programming' of these touch screens
onto empty touch screens.
Note that the 'Duplicate Programming' right click context menu option is the only way to
add CED based Smart Graphics extenders to an empty touch screen.
The programmer will not be allowed to copy CED based Smart Graphics extenders to any
other touch screen.
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Once at least one touch screen in an older program has been upgraded to reference a VTPro-e
project, the 'Upgrade?' dialog on program open will no longer be shown. A new dialog will be
shown reminding the programmer there are still touch screens to be upgraded.

Support of HDBaseT DM devices that will use the HDBaseT standard to directly control the serial port and IR
interfaces of 3rd party HDBaseT devices:

When an HDBaseT device is added to a DM Input or DM Output card, the DM Input or DM Output card
will now be assigned an IP-ID address.

When there is an HDBT device(s) present, the parent DM Input/Output card will take on the role
of "HDBT Master".
If there is more than one HDBaseT device added to an "HDBT Master", only one IP-ID will be
assigned to that "HDBT Master", to support all HDBT children of the master.

When the IP-ID is assigned to the "HDBT Master", a place holder 'In Use By HDBT' device will be added
to that IP ID on the Ethernet card.
The programmer can change the IP-ID assigned to the DM Input or DM Output card via the 'Endpoint IP
Net Address' configuration dialog.
If the "HDBT Master" does not contain an HDBaseT device, the address will not reflect an IP-ID.
The SIMPL UI will display this IP-ID as a part of the "HDBT Master's" address in both the System Design
tree, the Programming Tree and the Detail View.
The 'In Use By HDBT' place holder device cannot be deleted, moved or changed in any way, unless the
IP-ID is changed via the Configuration Dialog for the "HDBT Master".

HDBT IP-ID Caveats:
The DMPS-XXX-C control systems will assign an IP-ID to the DMPS Video card for all HDBT Devices that
may be added under that video card (as opposed to having the DM Input or DM Output cards be the
holder of the IP-ID).
The DM-MD6x6 and DM-MD6x4 switchers will internally handle the HDBT communications via Ethernet
without requiring an IP-ID to be assigned. Therefore, when adding an HDBT device to one of these
switchers, the programmer will not see an IP-ID assignment.

Fixes/Changes from 4.02.60 to 4.02.65

SIMPL Bug Fixes and Enhancements:

Reduced the amount of time the Signal List in the Program Tree takes to display.

SIMPL+ Bug Fixes and Enhancements:

Addressed a rebuild issue where an existing S# assembly, about to be replaced from an updated CLZ, is being
as flagged incompatible. When this occurs, the following message will appear: "Error 1706 (Line 2) - Error
including SIMPL# Library: 'Compatibility issue with <assembly name>="">.dll in <clz name>="">.clz'. This
condition can be rectified by performing a 'Recompile All'.

Fixes/Changes from 4.02.56 to 4.02.60

SIMPL Bug Fixes and Enhancements:

Added ability to enter decimal point delimited values for the BACnet Change Of Variance (COV) parameters on
the Analog Hosted Input Object and the Analog Value Input Object symbols. No updates or resynching will be
required to existing programs that currently have these symbols, however the programmer will now be allowed
to update existing values to contain decimal places.
For Windows 8.1 users only, the abort button during a compile is temporarily disabled. Abort of a compile was
causing a crash on the Windows 8.1 platform. This crash is being addressed and the abort button will again be
enabled when the problem is resolved.

SIMPL+ Bug Fixes and Enhancements:

Fixed output log at end of compilation such that the "Total Warning(s)" count represents the actual number of
warnings encountered.
The S# compatibility verification algorithm has been modified from requiring that all S# assemblies be the
same binary, to checking that their public API is compatible across all modules in a SIMPL system.

When the SIMPL compilation operation encounters an S# component (CLZ), the contents are read from
the manifest file and compared against the contents of the <SMW root folder>\SplsWork folder. If
there are no duplicate files, the contents are copied to the SplsWork folder and are used for
compilation.

If a duplicate filename is detected, it's considered a collision and the following compatibility
checking will be performed:

If manifests can be resolved for both assemblies, then the manifest identifiers are compared for equality. If
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they're equal, the original assembly in the <SMW root folder>\SplsWork folder is kept for compilation. If
they're not equal, the target assembly's public interfaces are inspected for compatibility.
The inspection of the assembly's public interfaces will ensure that one of the assemblies has a superset of all
public interfaces. The assembly deemed to have the superset of interfaces will be committed to the <SMW root
folder>\SplsWork folder and used for compilation.
Assemblies that have the same version and public API will then be compared using the modification date. The
assembly that has the later modification date will be committed to the <SMW root folder>\SplsWork folder and
used for compilation.

Note: If multiple SIMPL/SIMPL+ systems are stored in the same root folder, then S# dependencies for
all systems in that folder will be committed to the same SplsWork folder and subject to the
aforementioned compatibility verification.

Fixed issues with recompiling SIMPL+ modules.

Fixes/Changes from 4.02.53 to 4.02.56

SIMPL Bug Fixes and Enhancements:

Fixed crashes that could sometimes occur on Replace Control System. This was introduced in 4.02.53.
Fixed crash that could occur if a program is opened and referencing data missing in the currently installed
Device Database.
Fixed issue with not retaining the IP ID of DM endpoints when replacing a device such as a switcher, that
contains DM endpoint devices beneath it.

SIMPL+ Bug Fixes and Enhancements:

Fixed issue with sometimes getting header file errors on compile of SIMPL+ modules that include SIMPL#.

Fixes/Changes from 4.02.52 to 4.02.53

SIMPL Bug Fixes and Enhancements:

This version addresses performance issues encountered when opening and saving programs that have Smart
Graphics Extenders for Dynamic Lists controls. These programs should now be smaller file sizes and should
open and save much quicker. After a program with Dynamic Lists controls has been saved using 4.02.53, the
open and save times should be as expected.

Note 1: Opening an existing program with Dynamic Lists control(s), for the first time using SIMPL 4.032.53,
will still take a bit of time. In addition, the first time existing programs with Dynamic Lists Controls is saved
using 4.02.53 might also take a bit of time. However, after the initial open and save operations, the open/save
times should be more realistic.
Note 2: A minimum SIMPL Version of 4.02.53 will be required to open programs that have Dynamic Lists
controls and has been saved using 4.02.53 or greater. Programs that do not have Dynamic List controls will not
be affected and programs with only those types of controls, should still be able to open in older SIMPL versions.

Fixed issue with not retaining the IP ID of DM endpoints when replacing a DM endpoint devices with other
endpoints or the same model.

Fixes/Changes from 4.02.50 to 4.02.52

SIMPL Bug Fixes and Enhancements:

Added better error handling for the compiler option "Enable Auto-Archive on compile�. The compiler should no
longer return an Error if files are deemed to be missing from the SIMPL Archive. Since the SIMPL archive does
not affect the run time of the program, if SIMPL cannot find all files it thinks needs to be in the SIMPL archive,
Warning message(s) will be entered into the Error Log to identify the missing files.

SIMPL+ Bug Fixes and Enhancements:

Fixed an error where SIMPL+ writes Fatal SIMPL# compiler errors in the resulting .h header file. Not all error
messages were making it into that file.
Fixed �swallowing� of a FileNotFound exception where the user was not alerted to the actual problem, rather
they might just get a "Errors found" message with no indication of why. All compiler errors should now show.
Addressed cryptic SIMPL+ compilation messages resulting from Crestron Simpl# references.
Fixed error where the 'Total Number Of Errors' in the compilation output window was not showing the number
of errors if there were any.

Fixes/Changes from 4.02.49 to 4.02.50

SIMPL Bug Fixes and Enhancements:
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Fixed issue where the right click context menu option of 'Add' was disabled when selecting it from a top level
device such as an Ethernet, Cresnet, COM, IR, etc card, to select and add devices to the child slots of those
parent cards.

Fixes/Changes from 4.02.48 to 4.02.49

SIMPL Bug Fixes and Enhancements:

Added better address labels for DM Output and DM Input cards that sit in the DM-MD8x8, DM-MD16x16 and
DM-MD32x32 switchers. The addresses of the switcher slots, DM input, DM Output, and DM output channel
cards will now reflect which input or output stream(s), the device is addressing. This is to help make
programming of the DM Switchers a little easier. This is a data driven feature. Device Database version 57.05
or later will be required.

Fixes/Changes from 4.02.42 to 4.02.48

SIMPL Bug Fixes and Enhancements:

Smart Graphics Data Integrity Error: Fixed Data Integrity error for Smart Graphics Data: There is a bug in
SIMPL 4.02.38 where, a certain sequence of steps would wipe out part of the required Smart Graphics data
leaving the program unable to open. This version will allow the program to continue opening and will notify the
user that they will have to re-select the VTPro-e projects for the touch screens whose data got corrupt. If the
"missing data" message is displayed on program open:

the user should click YES on the dialog presented, to go to the Smart Graphics Management dialog. On
the Smart Graphics Management dialog, there will be an arrow with a black outline to the left of all touch
screens that the user will need to re-associate with a VTPro-e project.
If the user does not select the VTPro-e project at that time, or says NO to the message warning of
missing data, SIMPL will comment out all Smart Graphics extenders under the affected touch screen.
This is such that the user can continue to program and not be affected by the missing data.

When the user does re-select the VTPro-e project(s), SIMPL will try to match up the Smart
Graphics extenders from the selected SGD file, to the Smart Graphics extenders that were
commented out. If a match is found, the extender will be uncommented. If a match is not found,
a new extender will be added and the user can try to copy the proper programming from the
appropriate commented out extender. Note: Depending on how much data was lost, it is possible
that SIMPL might not be able to find a match.

Fixed error introduced to the 'Copy symbol Extenders' feature when working with older CED based Smart
Graphics data. The user can now select this option and copy programming from both Device Extenders and
Smart Graphics Extenders that are based on individual CED files.

Fixed error in Replace Control System sometimes losing the Smart Graphics Data if replace Control System is
performed and the program was not then saved.

Enabled 'Duplicate Device Programming' for touch screens that have the new association with VTPro-e projects.
This option was inadvertently disabled for these touch screens. Note that the touch screens must be the same.
When dragging a source touch screen that contains programming and/or device extenders and/or a VTPro-e
project and Smart Graphics extenders, onto a target touch screen of the same type, SIMPL will make sure that
the target touch screen gets the same VTPRO-e project, all Smart Graphics extenders and device extenders
and will copy all the programming from the source symbols to the target symbols. Any existing programming
or extenders on the target touch screen will be removed before the new ones are added.

Fixed error in trying to replace a 3-series control system with a DMPS-300-C. Only 2-series control systems
were allowing a replace to a DMPS control system.

Fixes/Changes from 4.02.40 to 4.02.42

SIMPL Bug Fixes and Enhancements:

Fixed issue where replacing a touch screen that is associated with a VTPro-e project, with another touch
screen, does not retain the VTPro-e project association. Smart Graphics extenders were retained but not the
VTP selection.
Fixed issue with reordering SGD based Smart Graphics extenders when older CED based extenders were still in
the program but commented out. All Smart Graphics extenders were erroneously getting commented out.
Fixed issue with red arrow always showing next to touch screens, in the Smart Graphics Management dialog,
that have VTPro-e projects selected. The red arrow implies a missing SGD file but this error was happening
because SIMPL was also looking for the backup SGD file.
Ensured that menu options associated with the new Smart Graphics Management method are not available
when working in programs based on the older CED based data.

SIMPL+ Bug Fixes: -Added enhancement to SIMPL+ compiler to write any "Fatal" error messages
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encountered in the compilation of a SIMPL# module, to the resulting .h header file. By putting
these messages in the .h file, SIMPL+ can now access this data and display the messages to the user
in the Status Window.

Fixes/Changes from 4.02.39 to 4.02.40

SIMPL Bug Fixes and Enhancements:

Added better support for locating VTPro-e and SIMPL files in the same folder: SIMPL will capture it's own copy
of the SGD file at the time the user selects a VTPro-e project or to refresh data from an existing project. This is
such that SIMPL can ensure the SMW will open without errors, or the need to resynch regardless of the activity
within VTPro-e. Updating the Smart Graphics data will now only be done based on user direction.
Added the ability to re-order Smart Graphics extenders under the parent touch screen: Left click and drag
Smart Graphics Extenders to reorder under the parent touch screen.
Added a right click menu option, "Copy Sequence of Smart Graphics Extenders", to impose the order of Smart
Graphics extenders on 1 touch screen, to another touch screen that references the same VTPro-e project.
Added a right click menu option, "Sort Smart Graphics Extenders", which will reorder the Smart Graphics
extenders for that touch screen by Control Join ID.
Added a right click menu option "Copy Smart Graphics Programming by Control Join ID", to copy programming
between Smart Graphics extenders by matching up Control Join Ids when VTPro-e projects for the 2 touch
screens are unlinked.

SIMPL+ Bug Fixes:

Fixed bug in SIMPL+ Editor where DEFINE_CONSTANT's appeared in structure drop down menus
Fixed bug where multi-threaded event subscriptions might fail to subscribe
Fixed compilation error when accessing arrays of SIMPL# classes from SIMPL+

Fixes/Changes from 4.02.38 to 4.02.39

SIMPL Bug Fixes and Enhancements:

Resolved a data integrity error that was sometimes encountered with Smart Graphics extender data after an
upgrade from an older CED based program.
Resolved issue with refreshing Smart Graphics extender data not updating the data when the VTPro-e files and
SIMPL Windows files are in the same folder.

Fixes/Changes from 4.02.21 to 4.02.38

SIMPL+ Bug Fixes:

Fixed bug where 'Open .API' doesn't work when .clz is located in a path specified within #INCLUDEPATH

SIMPL Bug Fixes and Enhancements:

Fixed error in creating archives that contain SIMPL# modules.
Added support for displaying friendlier names for Crestron devices and symbols in the Configuration
Management and Program Library trees. These names will be defined in the Device Database. Note that not all
devices will have this data. New devices and symbols are likely candidates, and older devices may be
retrofitted as appropriate.
Duplicate Programming function will now also copy Smart Graphics extenders to the target touch screen. If the
target touch screen has any smart graphics extenders already there, they will be removed (just like we do with
regular device extenders in this function) and new instances added.
Updated what is shown for the 'Add item to' option on the right click context menu of the configuration tree, if
the programmer selects an empty slot. SIMPL will now show the same label as is shown in the tree.
Fixed error when trying to import a RSD file after Smart Graphics data has been imported.

Better Smart Graphics data management:

Software Required: This feature requires VTPro-e 5.4.13 or higher, and Smart Graphics Controls is 2.01.06.02
or higher. You will not be able to create new programs with Smart Graphics data from VTPro-e, without these
versions. You will, however, be able to continue working with older programs that used CED files.

Summary:
Data defining all Smart Graphics controls in a VTPro-e project is now contained in 1 Smart Graphics
Definition (SGD) file. This file is generated by the VTPro-e compiler and will be used behind the scenes
by SIMPL.
Programmers now just need to select a VTPro-e project per touch screen and SIMPL will take care of
obtaining a copy of the new SGD file.
SIMPL will use the data in the SGD file to import/refresh/resynch Smart Graphics extenders for each
Smart Graphics control in the VTPro-e project.
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Programmers can select to refresh / resynch the Smart Graphics data on program open, or access the
Smart Graphics Management dialog at any time to refresh / resynch on demand.
Individual CED files no longer need to be maintained by the programmer but, for a transition period, can
still be generated by the VTPro-e compiler.

The new Smart Graphics Definition (SGD) file will be placed, upon successful VTPro-e compilation,
in the VTPro-e project folder.
Once a VTPro-e project has been selected and associated with a touch screen(s), the SGD will be
copied in the local SMW folder for use on the next SIMPL program open. Whenever a Smart
Graphics request is made by the programmer (either automatically on program open or on
demand), an latest copy of that SGD will be retrieved from the VTPro-e project file, and the
associated Smart Graphics extenders will be refreshed /resynched.

To begin using this feature
Read all of the release notes for this version, to be clear on what to do
If you are starting from scratch, just create a new program and use the Smart Graphics Management
dialog to import Smart Graphics data from VTPro-e projects compiled in VTPro-e 5.4.13 or newer.
If you are upgrading from and old-style CED file based program, here are some things to keep in
mind(details on how to upgrade are below):

It is highly recommended you use the same version of the VTPro-e project which generated the
CED files referenced your existing SIMPL program. Compile that VTPro-e project, using VTPro-e
5.4.13 or newer before trying to upgrade your SIMPL program.

After the upgrade, programmers will no longer need to worry about name or Control Join ID
changes.
Warning: If you have changed the name of the VTPro-e file name, the names of any of the
controls, or the Control Join IDs, since the last import of CED data into SIMPL, SIMPL will
not be able to find matching controls during the upgrade. In this case, SIMPL will comment
out the existing extenders (to retain the programming for copy/paste) and add new
instances from new data.

When upgrading your program, it is important to select a VTPro-e project for each touch screen
that had existing CED based data, before the next SIMPL program 'Save' / 'Save As'. Otherwise,
you may lose the existing Smart Graphics extender definitions and associated programming.
Known Issue if not upgrading older programs: If working in a program that was created using
SIMPL 4.02.21 or older, and the program contains Smart Graphics Extenders and the user selects
not to upgrade to the newer Smart Graphics Management method, the 'Copy Symbol Extenders'
option in the right click menu of a touch screen containing Smart Graphics Extenders will not be
enabled. A work around is to add a temporary regular device extender (such as an Ethernet
Offline Manager) to the touch screen. The menu option will become enabled, copy the extenders
and then delete the temporary device extender.

User Instructions:

Smart Graphics Management Dialog:
Accessible via the Project Menu->Smart Graphics Management, or the right click context menu of a
touch screen symbol.
There will be an entry for each touch screen that supports Smart Graphics.

A white arrow with a black outline in front of a touch screen means a VTPro-e project has not yet
been selected.
A red arrow means the associated Smart Graphics Definition (SGD) file for the VTPro-e project
could not be located in the SIMPL program folder. Make sure the VTPro-e project has been
compiled.
A magenta arrow means the selected VTPro-e project VTP file and/or the SGD file cannot be found
in the VTPro-e project folder (meaning, SIMPL would not have the latest files to access for a
refresh). This typically could happen after import of an archive to a different computer where the
VTPro-e project folder does not exist. Regardless of why the files are missing, SIMPL would then
use the local Smart Graphics data (SGD file) located in the SIMPL project folder (which would
represent the Smart Graphics data already in the SIMPL program).
Browse / Browse For All

Allows programmer to select VTPro-e project(s)
SIMPL will make a local copy of the associated SGD file in the SIMPL project folder. ( This is
to ensure the SIMPL program will open without errors due to missing data if the VTPro-e
project/files were ever moved.)
SIMPL will create/update Smart Graphics extenders under the associated touch screen(s),
for all Smart Graphics controls in the selected VTPro-e project(s).

Refresh / Refresh All
SIMPL will locate the SGD file in the VTPro-e project folder and update the SIMPL project
folder with that version.

Note: For each touch screen being refreshed, if any other touch screen also
references the same VTPro-e project, those touch screens will also get
refreshed/resynched. The programmer will be shown a list of the touch screens that
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will also be updated and the programmer can select to continue or abort the refresh.
If a new Smart Graphics control has been added, SIMPL will add an associated extender.
If a Smart Graphics control already has an extender in the SIMPL program, SIMPL will
resynch the definition of that extender.
If a Smart graphics control has been removed from the VTPro-e project (or marked as 'do
not compile', or was not yet assigned a valid Control Join ID), SIMPL will comment out the
associated Smart Graphics extender in the SIMPL program. This is done such that the
programming will still be available to the programmer (in case it's needed to copy/paste
elsewhere).
Commented extenders will be the responsibility of the programmer to remove from their
project.
The programmer will not be able to uncomment these Smart Graphics extenders. This is
done to avoid possible data integrity errors on future program opens. However, the
programmer can always delete any commented out Smart Graphics extender.

Clear / Clear All:
SIMPL will remove all Smart Graphics extenders found in the associated SGD, from the
selected touch screens.
SIMPL will disassociate the selected touch screens from the VTPro-e project(s).

Do not automatically refresh/resynch Smart Graphics data on program open:
Keep this option selected if you do not want SIMPL to go get the latest SGD file(s) and
perform a refresh/resynch on each program open.

Changing the name of your VTPro-e project:
If the name of a VTPro-e project changes, go to the Smart Graphics Management dialog and select the
new VTPro-e project name.
SIMPL will be able to use unique control identifiers to find the matching extenders already in the SIMPL
program, and refresh / resynch the data. See the 'Refresh / Resynch Notes' section below for more
details on this process.

Changing the name of a Smart Graphics Control, or changing the Control Join ID:
SIMPL will be able to use unique control identifiers to find the matching extenders already in the SIMPL
program, and refresh / resynch the data.

Upgrading existing programs with CED based Smart Graphics extenders:
Recommendation: Before upgrading existing projects using CED files, create a SIMPL Archive.
On program open, SIMPL will detect if there are Smart Graphics extenders based on older CED files. If
so:
The programmer will be provided the following options:

Upgrade:
The Smart Graphics Management dialog will be displayed so the programmer can select the
appropriate VTPro-e project.
SIMPL will try to find matches to the existing Smart Graphics extenders, using the
associated CED name assigned to each control by VTPro-e (i.e. <VTP project=""
name_control="" name>="">.ced). After that initial upgrade, the control's unique control
identifiers will be used for future data refresh operations.
If a match cannot be found:

SIMPL will comment out the existing extender.
Note: The programmer will not be able to uncomment this Smart Graphics
extender. This is done to avoid possible data integrity errors on future
program opens. However, the programmer can always delete any commented
out Smart Graphics extender.

SIMPL will add a new extender based on the data in the SGD
New extenders will be added for controls that have been added since the last CED import.
Existing extenders not found in the SGD file will be commented out.

Not right now:
Keep using the older CED files for this session. The programmer will be asked to upgrade
on the next program open. Select this option if you want to go create an archive before
doing an upgrade, or if you don't have the latest VTPro-e installed but are intending to do
so.

Don't ask again:
Keep using the older CED files for this session. The programmer will not be asked again to
upgrade but can access the Smart Graphics Management dialog at any time to perform an
upgrade.

Upgrade Notes:
When accessing the Smart Graphics Management dialog for the first time, Crestron recommends
selection of a VTPro-e project for each touch screen that currently refers to CED files, at this time.

Once the programmer selects at least one VTPro-e project, SIMPL will consider every touch screen
in the program as 'upgraded' to use the new SGD file data.
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Important! Any touch screen that does not get a VTPro-e project assigned before the first 'Save'
/ 'Save As' after selecting to upgrade, will result in that touch screen's current CED based Smart
Graphics extenders data to be commented out. If you close the program and then reopen, you
may lose the Smart Graphics extender names and symbol definitions.
If SIMPL comments out any old CED based Smart Graphics extender during an upgrade, try to
copy the programming of the older extender to the new instance (if a new instance was added)
before saving and closing your program.

Note: The programmer will not be able to uncomment Smart Graphics extenders. This is
done to avoid possible data integrity errors on future program opens. However, the
programmer can always delete any commented out Smart Graphics extender.

If the programmer chooses to upgrade to the new Smart Graphics Management method:
SIMPL will not remove any CED files referenced by this program, from the project folder. This is to
ensure that other programs in the same folder, not yet upgraded, will open successfully.
Therefore, it is the responsibility of the programmer to remove any unused CED files from the
project folder, when deemed safe.

If the programmer does not upgrade and chooses to continue to use individual CED files:
If importing a new CED file not already in your program, find and select that file. SIMPL will
import the CED data and make a copy of the CED file in the program folder.
If the CED file is already referenced in the SIMPL program and has been updated by VTPro-e, you
must remember to copy any updated CED files to your SIMPL program folder.
Do not put your VTPro-e project folder in the SIMPL project folder.

Refresh/Resynch Notes:
Smart graphics controls will be tracked internally ( by both VTPro-e and SIMPL) via unique internal
identifiers for better resynch support in SIMPL.

If the object name or any of the control's attributes change in the VTPro-e project, SIMPL will still
be able to match it up to the associated extender in the SIMPL program , using the control's
internal identifier.
If the programmer does a 'Save As' of a VTPro-e project to a different project name, VTPro-e will
now allow the user to define their intent of the 'Save As' (see VTPro-e help for information on
linking projects):

Create new project (unlinked): The VTPro-e user can do a 'Save As' to create a new,
unlinked, project based on the existing project. VTPro-e will assign new internal tracking
IDs, for all controls, such that the new project's Smart Graphics data can be imported into
SIMPL without affecting/updating any Smart Graphics data currently in the SIMPL program
from the original project.
Create new version (linked): The VTPro-e user can do a 'Save As' to create a new version
(i.e. link the newly saved version to the previous version) of the existing project, thus
maintaining history and traceability of all controls.

In SIMPL, when the programmer selects one or more touch screens to associate with
a new VTPro-e project name, SIMPL will look at all non-selected touch screens to see
if any of those currently reference the same VTPro-e project (Note: this search is
done based on an internal project identifier and not VTP file name).
If any non-selected touch screen references the same VTPro-e project, and that
VTPro-e project is a linked project, SIMPL will tell the programmer that all Smart
Graphics data from that project, on all touch screens that referenced the previous
version, will be refreshed /resynched. A list of those touch screens will be displayed.
The programmer will have the option to abort the process of using the new VTPro-e
project, to allow SIMPL to update the data on the non-selected touch screens.

Copying programming from 1 set of Smart Graphics extenders to another touch screen:
The programmer can copy the programming from the Smart Graphics extenders on one touch screen, to
the Smart Graphics extenders on any other touch screen that is associated with the same VTPro-e
project.

Make sure the VTPro-e project associations are assigned to the proper touch screens in the Smart
Graphics Management dialog.
In the Program Tree, program one set of Smart Graphics extenders
select that touch screen, right click and drag it to another touch screen that is associated with the
same VTPro-e project.
SIMPL will copy the programming from each Smart Graphics extender in the selected touch
screen, to the matching Smart Graphics extender in the target touch screen.

Similarly, if the programmer wants to just copy the programming for 1 Smart Graphics extender, to
another that is from the same VTPro-e project, they may select just that Smart Graphics extender, right
click and drag it to an instance of the same extender on another touch screen.

Fixes/Changes from 4.02.20 to 4.02.21

SIMPL Bug Fixes and Enhancements:
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The default program archive option, at compile completion, has been restored to 'Create Archive. This will
result in creation of a SIMPL Archive. The recently added Compiler Settings option to 'Create archive and
embed in compiled program' option will no longer be the default.

SIMPL+ Bug Fixes:

Fixed link error when using S# Variables as NONVOLATILE. S# Variables are now compiled as VOLATILE.
Fixed bug when using classes defined in another namespace

Fixes/Changes from 4.02.18 to 4.02.20

SIMPL Bug Fixes and Enhancements:

Fixed issue where right clicking on the Control System in the Configuration Management tree seems to take a
long time to respond.
Fixed a bug where SIMPL archives could not be created. This could occur when SIMPL+ relative paths are in
use.
Fixed issue with saving a module to a different name sometimes loses the Symbol Tree Category setting.

SIMPL+ Bug Fixes:

Force a recompilation when modules are moved to another folder.

Fixes/Changes from 4.02.17 to 4.02.18

SIMPL Bug Fixes and Enhancements:

Updated to new icon and splash screen.
Duplicate Programming will now copy device extenders and their programming. Smart Graphics are not yet
supported as a part of this feature.

Known Issue:

Saving a Module losing data: Sometimes, if you save a module to a different name after performing a save in
the same session of SIMPL Windows, the Symbol Tree category may get lost. If you don't see your module
appear in the Symbol Library, please open the module in SIMPL editor, edit the Module Header and reselect the
proper Symbol Tree category and then save the module. You may need to Reload the Libraries or restart SIMPL
to see the module after that.

SIMPL+ Bug Fixes:

Implemented support for Continue statement in loops: This keyword causes control to pass to the end of the
innermost enclosing WHILE, DO or FOR statement, at which point the loop continuation condition is re-
evaluated.

Note: CONTINUE statement in SIMPL+: with the added support of the CONTINUE statement in SIMPL+, any
existing modules that use the word 'Continue' as a variable will not compile correctly. Please
change the variable name and recompile.

Fixes/Changes from 4.02.16 to 4.02.17:

SIMPL Bug Fixes and Enhancements:

Fixed an error in compilation where COM ports were sometimes being removed accidentally.
Updated to new splash screen and icon.
Fixed Duplicate Programming to also copy the comments of the child symbols
Updated the Duplicate Programming dialog to retain the last entered "Replace" and "With" values
Fixed error where performing a 'Copy all Signals/Parameters' or 'Duplicate Programming', was leaving the
destination symbol incorrectly marked as incomplete.
Fixed error when copying/pasting signals from one IR device to another. The destination IR device was getting
it's IR commands overwritten to be the commands of the source device, thus causing compile errors.

Known Issue Note:

Saving a Module losing data: Sometimes, if you save a module to a different name after performing a save in
the same session of SIMPL Windows, the Symbol Tree category may get lost. If you don't see your module
appear in the Symbol Library, please open the module in SIMPL editor, edit the Module Header and reselect the
proper Symbol Tree category and then save the module. You may need to Reload the Libraries or restart SIMPL
to see the module after that.

SIMPL+ Bug Fixes:
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Implemented #INCLUDEPATH for specifying additional include paths for user libraries (3-series only).

Note: SIMPL+ changes to functionality for #INCLUDE_SIMPLSHARP_LIBRARY (SIMPL version 4.02.17 and
higher) - Absolute Paths are no longer accepted within the compiler directive,
#INCLUDE_SIMPLSHARP_LIBRARY. Both Absolute and Relative Paths are now supported using the compiler
directive, #INCLUDEPATH. One or more #INCLUDEPATH directives can be specified and must be placed
before any #INCLUDE_SIMPLSHARP_LIBRARY compiler directives. The search order for libraries is 1)
Project Folder, 2) Global SIMPL+ Folder and 3) #INCLUDEPATH folders.

Fixed possible link error when calling static functions within an event (3-series only).
Fixed error where calling Remove() from within a callback function was failing to update the string (3-series
only).
Fixed bug where for-loops can run into infinite loops (2-series only).

Fixes/Changes from 4.02.14 to 4.02.16:

Note:

A minimum Device Database version of 50.00.01 is required with SIMPL 4.2.15
A minimum 3-series control system firmware version of 1.007.0019 is required with SIMPL 4.2.15

SIMPL Bug Fixes and Enhancements:

Fixed an issue where sometimes a new SIMPL+ project module is not compiled into a program. This was only
happening if the programmer created a new SIMPL+ module in the current SIMPL project folder, while SIMPL is
open with the project. Forcing SIMPL to reload the device and symbol data would rectify the situation before
this fix.

SIMPL+ Bug Fixes:

Fixed crash if undefined variable is used within for-statement (3-series only)
Fixed possible compilation failure when calculating NVRAM.

Fixes/Changes from 4.02.13 to 4.02.14:

SIMPL Bug Fixes and Enhancements:

Fixed bug in compiler where UIDs were not being written to the SIMPL BIN file correctly if the UID had a zero in
it.

SIMPL+ Bug Fixes:

Fixed possible compilation error when using strings as function arguments with library function calls.

Fixes/Changes from 4.02.12 to 4.02.13:

SIMPL Bug Fixes and Enhancements:

Added logic to not allow users to select a Device or Symbol in the programming tree, right click and drag onto
itself and have the option to copy signals, duplicate device programming etc.
Fixed bug in BACNet XML generation to not write commented signals to the XML file.
Optimized "Copy All Signals/Parameters" function when the source and target symbols are identical (e.g. copy
from 1 TSW-750 to another TSW-750).

SIMPL+ Bug Fixes and Enhancements:

Fixed Bug where ResizeArray and ResizeStructureArray could cause a link error if used within an if-statement
Fixed possible compilation errors when including libraries within SIMPL+ on multi-language Windows
distributions
Fixed broken functionality where global vars were being allowed to be declared within .usl's (3-series only).

Fixes/Changes from 4.02.11 to 4.02.12:

SIMPL Bug Fixes and Enhancements:

Fixed bug where the 'Target Fusion Processor' menu option became disabled and unavailable if the user deleted
a Target Fusion Processor from the list.

SIMPL+ Bug Fixes and Enhancements:

Fixed Bug where ResizeArray and ResizeStructureArray could cause a link error if used within an if-statement
Fixed possible compilation errors when including libraries within SIMPL+ on multi-language Windows
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distributions

Fixes/Changes from 4.02.10 to 4.02.11:

SIMPL Bug Fixes and Enhancements:

Duplicate Device Programming Feature (to support easier copying of MLX-3 data): implemented the ability in
the Program Tree, to select a device symbol, right click and drag it to another instance of the same device
symbol (e.g. MLX-3 and it's pages) and select the right click menu option "Duplicate Device Programming".
Note that the user must add both the source and target devices to the program:

With both top level devices added, and any child devices added to the source device, go to the
Programming Tree and program the source device and it's children.
From the Programming Tree, select the device to copy, right click and drag that to the target device
(e.g. select the MLX-3 with programming to be copied and drag it to the target MLX-3).
if the target device already has programming or child devices, a dialog will warn the user that
proceeding with result in deletion of the existing source device programming and child devices.
A dialog will appear asking for a Signal Prefix, and/or a Signal Suffix and/or a string to be replaced. The
user can provide any, all or none of these options. The resulting signals on the source device will apply
the selected prefix/suffix/string replacement.
all programming on the selected device symbol will be copied to the target device symbol. If the target
already had programming, that programming will be removed and replaced with what is on the
associated source symbol.
any child devices/device symbols under the selected device symbol will be added to the same address on
the target. If the target already had children, they will be replaced. If the target has a child device at an
address where there is nothing on the source, that child will be removed from the target. E.g. the target
device hierarchy will look exactly like the source.
all programming on the source child device symbols will be copied to the appropriate target device
symbol.

Optimized the processing that occurs after a SIMPL+ module has been compiled: If SIMPL is open, and the
SIMPL+ module was new or had compile errors, SIMPL and SIMPL+ Editor can become unresponsive for an
unnecessary amount of time. This has been optimized to remove the large time delay. Please note however,
that if you have a large amount of modules (SIMPL or SIMPL+) in your User Module folders, your overall SIMPL
performance will take a hit. When possible, it is always recommended to use Project Modules to ensure that
SIMPL is only loading data that is needed for the project being edited.

Removed SIMPL Debugger menu option and Tool bar button since the only thing that happens when it is
selected is the user is told to start it via Toolbox.

SIMPL+ Bug Fixes and Enhancements:

Fixed application crash on 3-Series compilations when compiling without Admin Privileges.

Fixes/Changes from 4.02.09 to 4.02.10:

SIMPL Bug Fixes and Enhancements:

Fixed bug with library files not being extracted from SIMPL archives.

Fixes/Changes from 4.02.08 to 4.02.09:

SIMPL Bug Fixes and Enhancements:

Fixed bug with library files not being added to SIMPL archives.

Fixes/Changes from 4.02.07 to 4.02.08:

SIMPL+ Fixes/Enhancements:

Fixed bug with exporting modules with libraries

Fixes/Changes from 4.02.06 to 4.02.07:

SIMPL+ Fixes/Enhancements:

Fixed bug when using Parameters within Resize functions (3-series only)
Fixed bug where for-loops would not exit if values were over 32767 (2-series only)

Fixes/Changes from 4.02.05 to 4.02.06:
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SIMPL+ Fixes/Enhancements:

Fixed bug where some libraries were not being exported

Fixes/Changes from 4.02.04 to 4.02.05:

SIMPL Bug Fixes and Enhancements:

Fixed Replace Control System to try to copy DM Endpoint devices to the proper location (i.e. if they were
originally on a DM card, then put them there in the new system. If they were originally on the Ethernet card,
them put them there in the new system)
Fixed Replace Control System to try to copy as much programming as possible from the System Control
module that comes with some control systems (e.g. DMPS-300-C) over to newer versions of the System
Control module.

Fixes/Changes from 4.02.03 to 4.02.04:

SIMPL+ Enhancements:

Added additional security for generated SIMPL+ modules

Fixes/Changes from 4.02.02 to 4.02.03:

SIMPL+ Enhancements:

Added function: IsNull (3-series only).

Fixes/Changes from 4.02.01 to 4.02.02:

SIMPL+ Enhancements:

Added class objects CMutex and CEvent (3-series only).

Fixes/Changes from 4.02.00 to 4.02.01:

SIMPL Bug Fixes and Enhancements:

Updated error message for Replace Control System when 'fixed' devices (devices that come along with another
device and are not stand alone devices), are not moved to the new project. This message will instruct the
programmer to verify that all programming was copied over or, to manually copy the programming as
applicable.

SIMPL+ Enhancements:

Fixed bug where compiling SIMPL+ modules containing .usl's could result in a compile error (bug was
introduced in v4.02.00)
Fixed bug where undefined labels within Wait Statements could cause crash (3-series only)

Fixes/Changes from 4.01.10 to 4.02.00:

SIMPL+ Enhancements:

Support for FW .NET 3.5
Minimum required Include4.dat set to 2.09.14

Fixes/Changes from 4.01.09 to 4.01.10:

SIMPL Bug Fixes and Enhancements:

Fixed a problem in Replace Control System for some DMPS-300 systems where serial devices were not being
copied over.
Fixed a problem when trying to open DMPS programs created with a Device Database older than 43.05.01,
when a newer database is in usefor the program open. If the program was recompiled using the newer
database, the COM ports could stop working.

Fixes/Changes from 4.01.08 to 4.01.09:

SIMPL Bug Fixes and Enhancements:

Saving extra device information to the SMW file to support better error messaging and easier SMW imports in
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Crestron Studio. Data being written will be the Release Status of the device (Released, Beta, Test or not
supported by Crestron Studio), and the Crestron Studio Product Line. This will help Crestron Studio users know
which database packages they may need to install.

Fixes/Changes from 4.01.06 to 4.01.08:

SIMPL Bug Fixes and Enhancements:

Fixed error in Create Archive that was sometimes missing some user SIMPL+ module files.

Fixes/Changes from 4.01.05 to 4.01.06:

SIMPL Bug Fixes and Enhancements:

Fixed the Help About screen to show the correct version of SIMPL+.
Fixed the interface to Crestron Toolbox for 3-series systems that have authentication enabled to prompt for
user name and password. SIMPL+ Bug Fixes and Enhancements:
Fixed error in SIMPL+ modules that contain both _SKIP parameters and Parameter Property definitions. The
parameter property definitions were not accounting for the skipped parameters and as such, were being
associated with the wrong parameter. Note: If using an existing SIMPL+ module that has both _SKIP
parameters and Parameter Property definitions, you will need to open that module in SIMPL+ and recompile it,
and then Resynch the programs that have that module. You will have to manually adjust any default values
that were set on Parameters via the Parameter Property definitions when the older version of the module was
added to the program. Those default values were probably originally assigned to the incorrect parameter.

Fixes/Changes from 4.01.04 to 4.01.05:

SIMPL Bug Fixes and Enhancements:

Fixed issue where replacing a control system was adding the default serial driver device to COM cards on the
new system. This meant that programming was sometimes lost. Now, SIMPL will attempt to add the default
driver that is associated with the new control system.

SIMPL+ Enhancements:

Fixed error in compiling SIMPL+ modules that have User Libraries.

Fixes/Changes from 4.01.03 to 4.01.04:

SIMPL Bug Fixes and Enhancements:

Fixed issues with adding DM Endpoint devices to Ethernet cards with limited IP IDs, or when all IP IDs were
taken.
Crestron Database version: Crestron Database version 34.01.002, or newer, is recommended for this version.
SIMPL+ fixed an issue that required us to have to fix and rebuild 3 Crestron SIMPL+ modules. The following 3
modules will have compile errors with older Crestron Database versions: Kaleidescape SATP Processor
v7.0.0.csp (Kaleidescape SATP Processor v7.0.0 (cm)) DSC PowerSeries LED to Text v1.0.csp (DSC
PowerSeries LED to Text v1.0 (cm)) HoneyA.csp (Honeywell Enviracom Processor (cm))

Fixes/Changes from 4.01.01 to 4.01.02:

SIMPL Bug Fixes and Enhancements:

Fixed issue where .lpz file was not adding all files correctly
Fixed Convert To Crestron Module to support Media Player modules

Fixes/Changes from 4.01.00 to 4.01.01:

SIMPL Bug Fixes and Enhancements:

Fixed issue with SIMPL+ Library files

Fixes/Changes from 3.11.20 to 4.01.00:

SIMPL+ Enhancements:

Media Player support.
For future language support:

New Reserved Keywords: namespace, class, delegate, static, EventHandler, DelegateProperty
New SIMPL+ Keywords: RegisterEvent, UnregisterEvent, RegisterDelegate, UnregisterDelegate,
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EventArgs, callback, CMutex, CEvent
Support for nested Structures

Installing the Crestron Database and Device Database

In order to program in SIMPL, the Crestron Database and Device Database are required. These databases provide
definition of the Crestron devices, and a collection of support files that SIMPL requires to allow you to add Crestron
modules, and third party devices to your programs. These databases can installed using the Crestron Master Installer
tool, or on www.crestron.com.

Installing the SIMPL+ Cross Compiler

To use SIMPL+ for the 2 Series control systems, you install the SIMPL+ Cross Compiler. This can be downloaded and
installed using the Crestron Master Installer tool, or on www.crestron.com.

Installing the Crestron Toolbox

In order to communicate, upload to, and manage Crestron equipment, install the Crestron Toolbox. This can be
downloaded and installed using the Crestron Master Installer tool, or on www.crestron.com. Note that the Crestron
Toolbox is not compatible with processors prior to the 2 Series (X Generation, ST-CP, and CNMS era control systems).
To use these processors, you will need to use the legacy Viewport utility.-

Crestron Electronics, Inc.
Rockleigh, NJ 07647
Tel: 800.237.2041/ 201.767.3400
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